Yakkity Clock Help

These are the main categories in the Yakkity Clock help system. Choose a category below to see a list of available
help topics.

Q‘B Getting Started: An introduction to Yakkity Clock.
Basic Skills: Configuring and using Yakkity Clock.
Q Appendices: Supplementary information about Yakkity Clock.

For additional documentation, please refer to the README.TXT file.



Yakkity Clock Help

These are the main categories in the Yakkity Clock help system. Choose a category below to see a list of available
help topics.

l:ﬂi Getting Started: An introduction to Yakkity Clock.
Yakkity Clock Overview
Installation & Setup
The Yakkity Clock Interface
Menu Commands
@ Basic Skills: Configuring and using Yakkity Clock.

Appendices: Supplementary information about Yakkity Clock.

For additional documentation, please refer to the README.TXT file.



Yakkity Clock Help

These are the main categories in the Yakkity Clock help system. Choose a category below to see a list of available
help topics.

Q‘B Getting Started: An introduction to Yakkity Clock.

Basic Skills: Configuring and using Yakkity Clock.
Using Yakkity Clock
Setting Alarms

Appendices: Supplementary information about Yakkity Clock.

For additional documentation, please refer to the README.TXT file.



Yakkity Clock Help

These are the main categories in the Yakkity Clock help system. Choose a category below to see a list of available
help topics.

Q‘B Getting Started: An introduction to Yakkity Clock.
Basic Skills: Configuring and using Yakkity Clock.

Q Appendices: Supplementary information about Yakkity Clock.
Product Registration
Registration Form
Product Support
Limited Warranty
About Yakkity Clock

For additional documentation, please refer to the README.TXT file.



Yakkity Clock Overview

Yakkity Clock is a talking clock accessory for the Microsoft® Windows operating environment. The Yakkity Clock
executable is a 16-bit application, designed to run on Windows 3.1x, Windows for Workgroups, Windows 95 or later,
or Windows NT.

Yakkity Clock can function as a simple clock application, reporting the current time at the press of a button or at
user-defined intervals. The clock offers users their choice of male or female voices for voice-time announcements.
The program's four independent alarms can be configured to play sound or music just like a clock radio. Available
alarm sounds include the program's default "built-in" sounds, waveform audio (*.WAV) files, MIDI sequencer (*.MID)
music files, or audio CD discs.

Yakkity Clock alarms can also be configured to launch assigned applications, making the program a handy tool both
for scheduling and automating tasks.

See also...
Installation & Setup



Installation & Setup

User Hard Drive
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Working Directory (e.g., c:\yakclock)

Yakkity Clock Program Files

yakclock.exe (executable file)

yakclock.hlp (help file)

support libraries (9 files: ycsnd01.dll - ycsnd09.dll)
readme.txt (ASCII text file)

Assignable Sound & Music Files

multimedia files (*.wav, *.mid) or audio CDs

A typical installation creates a new directory (e.g., c:\yakclock) on your hard disk and places the Yakkity Clock
application executable, the application help file, and a few support files in this location. One or more
supplementary document files (e.g., README.TXT) may be installed, too.

The installation should add a new Yakkity Clock shortcut into your Taskbar Start Menu (or a Program Manager group,
if you are using an older version of Windows). Selecting this shortcut will launch Yakkity Clock. If your copy of
Yakkity Clock did not include an installation utility, you can copy all of the program files into a destination directory
and assign a Start Menu shortcut to YAKCLOCK.EXE manually (refer to the README.TXT file for Quick & Dirty
Installation information).

Note: In order for Yakkity Clock to play its built-in sound effects, waveform audio files, MIDI sequencer files, or
audio CD titles, your PC should have an installed sound card or other audio hardware, with the appropriate device
drivers correctly configured for use under Windows.



The Yakkity Clock Interface
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To make efficient use of Yakkity Clock, users should become familiar with the program's interface. There are four
major components to the Yakkity Clock program window:

» The Caption Bar
* The Menu Bar

» The LED Clock Face
» The Voice-Time Button

The caption bar can optionally be configured to display the current time (via the Configuration dialog).

Tip: The Yakkity Clock window can be reduced to the caption bar alone via the Alt+T key combination or by
moving the cursor over the LED clock face area and "double-clicking" the left mouse button. Using Alt+T again
toggles the window back to its normal appearance. Even while the program window is toggled to its smaller
"caption-only" state, selected menu bar commands are available from the program's system menu. Key
combination shortcuts are always available, regardless of the program window state.

See also...

Menu Commands
Using Yakkity Clock
Setting Alarms



Menu Commands

The following commands are provided in the Yakkity Clock menu bar. Click on any command to display a summary
of its function.

File
» Exit (Alt+F4)

Options
» Configure... (Alt+C)
» Set Alarm 1 (Alt+1)
+ Set Alarm 2 (Alt+2)
+ Set Alarm 3 (Alt+3)
» Set Alarm 4 (Alt+4)

Help
» Contents (F1)
» Registration Information
» About Yakkity Clock

Note: Selected menu bar commands are also available in the Yakkity Clock system menu, and can be accessed
even when the program window has been toggled to its smaller "caption-only" state.



Using Yakkity Clock

Yakkity Clock's accuracy depends exclusively on the current time reported by your computer's system clock.
Assuming your PC's system clock is accurate, Yakkity Clock is fully functional as soon as the program is launched.

You can always have Yakkity Clock provide a voice-time update by clicking on the voice-time button at the bottom of
the program window. If you wish to have the clock provide time reminders on its own, you should select the menu
bar "Options / Configuration..." command (or use the Alt+C key combination), which opens the Yakkity Clock
Configuration dialog box. This dialog contains controls for selecting the gender of the voice, the frequency of
voice-time reminders, and several other program options.

Note: Yakkity Clock's voice-time functions require that the host PC be equipped with a sound card or other audio
hardware, with the appropriate device drivers correctly configured for use under Windows.

See also...
Menu Commands

Setting Alarms



Setting Alarms

Yakkity Clock provides four independent alarms. Changes to each alarm's settings are made via the individual
alarm dialog boxes as follows:

1. Select the menu bar "Set Alarm X..." command, where X is the number of the alarm you wish to set. This opens
the selected alarm's configuration dialog box. You can also make use of the Alt+1, Alt+2, etc. key commands for
displaying these dialog boxes.

2. Find the control group labeled Alarm Sound Selection. Here, you can select from several types of sounds or
music to play when the given alarm triggers. Built-in sound effects are available at all times. If you have a CD-
ROM drive, you can load an audio CD and have Yakkity Clock start playing the CD in conjunction with the alarm.

Yakkity Clock alarms can also be associated with installed applications and/or multimedia files. To assign an
application to an alarm, use the Browse... button to display a file selection dialog box, choose application (*.exe)
as the file type and select the application executable for the alarm to launch. To assign a multimedia file to play as
the alarm sound, use the Browse... button to display the file selection dialog box, choose waveform audio
(*.wav) or MIDI sequencer (*.mid) as the file type, and select the sound or music file for the alarm to trigger.

3. Find the control group labeled Alarm Time. Pushbutton controls are provided for adjusting the alarm time as
displayed.

4. An Enable Alarm checkbox control is provided. This control turns the selected alarm on and off.

5. When you have finished making your selections, close the dialog box via the OK pushbutton. The new settings
are put into effect immediately.

Note: When two or more alarms are set to the same time, alarm sound effects are played in order (i.e., Alarm 1,
Alarm 2, etc.). If .WAV files are selected for use as alarm sound effects, the alarm sound will play completely in the
background, but may be interrupted by "built-in" alarm sound effects if additional alarms are triggered at the same
time. For this reason, it is recommended that care be taken to avoid setting multiple alarms for the same time.

See also...
Menu Commands

Setting Program Options



Appendix 1: Product Registration

The "Evaluation Version" of Yakkity Clock is intended for evaluation purposes only; the product is not distributed as
"freeware."

You are welcome to install and run the evaluation version of this product for a 20-day period; if the product meets
your needs and you wish to continue using it, we ask that you take the time to register.

Registered users are shipped the registered version of this product on disk. The registered version contains no
expiration dates, "nag screens," or pop-up registration dialog boxes. Registered users also receive free telephone
technical support as well as advance notice of upcoming Pegasus Development releases, including updates or
upgrades to this application. Prior registration entitles users to substantial discounts when ordering a program
update or upgrade, often as much as 50% off the standard registration fee. Finally, as a registered user, you can
qualify for free beta copies of upcoming program releases, giving you the chance to "test drive" versions of exciting
new products months before their official release dates.

The registration fee for this product is $20.00 U.S.

- Registrations ordered from the U.S. or Canada should include $2.00 per copy for shipping & handling.

* Registrations ordered from outside the U.S. or Canada should include $3.00 per copy for shipping & handling.
= Checks and/or money orders must be drawn on a U.S. bank.

Registrations are handled by our distributor, Advanced Support Group, Inc., and can be ordered by mail, by
telephone or fax (with a major credit card), or by electronic mail.

Telephone: (314) 965-5630
1-800-788-0787

Fax: (314) 966-1833

Standard Advanced Support Group

Mail: 11900 Grant Place

St. Louis, MO 63131 USA

E-Mail: 76711.1171@compuserve.com
Site licenses and multi-user registrations are available. Please contact Advanced Support Group for information.
Orders are normally shipped via standard U.S. mail services (domestic U.S.). Overseas orders are normally shipped
via U.S. mail (small packet). For an additional fee, both 2-day Priority Mail and next-day shipping (via Federal
Express) are available; please call for shipping rates.
All credit card registrations will appear on your statement as "ASG Software/Services."
Note: Registered copies of Yakkity Clock are normally shipped on 3.5" disk media. If you wish to receive your
registered copy of Yakkity Clock on 5.25" disk media, please let us know at the time of your order.
Registration Form Printing
For your convenience, a printable registration form is provided in this help file, which can be used for fax or mail
orders. The Windows Help system provides a convenient feature for printing the registration form (or any help
topic) directly from this file.

To use this feature, follow these steps:

1. Turn on your printer. Standard letter (8 1/2 x 11) or legal (8 1/2 x 14) paper should be loaded for single-sheet
printing of the entire registration form.

2. Move to the topic you wish to print ("Registration Form" in this case).

3. Select the Windows Help menu bar "File/Print Topic" command.

See also...



Registration Form



Appendix 2: Registration Form

Please return this form along with your payment to:
Pegasus Development / ASG

Yakkity Clock 2.0 Registration

11900 Grant Place

St. Louis, MO 63131 U.S.A.

You can register by telephone using your credit card through Advanced Support Group's software order lines!
Call 1-800-788-0787 or (314) 965-5630.

FAX registrations (using a copy of this form) are also accepted; the ASG fax line is (314) 966-1833.
Please send me Yakkity Clock 2.0 registration(s) at $20.00 U.S. each.

Registrations ordered from the U.S. or Canada should include $2.00 per copy for shipping & handling.
Registrations ordered from outside the U.S. or Canada should include $3.00 per copy for shipping & handling.

Total Enclosed: $

Payment Method: [ ] Check [ 1VISA [ 1 MasterCard [ TAMEX

Cardholder Signature

Expiration Date

Ship To:

Name

Address

City State/Province

Zip/Postal Code Telephone Number



Appendix 3: Product Support

If you have a problem with this program, and can't find the answer in this help file or any of the enclosed text file
documentation, you can contact Pegasus Development's Technical Support Hotline (furnished courtesy of Advanced
Support Group, Inc.) by telephone Monday through Friday from 9:00 a.m. to 4:00 p.m. Central Time.

Please contact us via...

Telephone: (314) 965-5630

Fax: (314) 966-1833
Standard Pegasus Development
Mail: c/o ASG, Inc.

11900 Grant Place
St. Louis, MO 63131 USA

E-Mail: 76711.1171@compuserve.com

Users are encouraged to visit the Pegasus Development site on the World Wide Web. Our web site provides quick
access to downloadable product updates, patches, supplementary documentation, and release notes regarding
most Pegasus Development applications.

Internet/ http://www.imktg.com/pegasus
WWW:

In any correspondence regarding this product, please be prepared to furnish us information regarding your PC
hardware (including installed sound cards and other multimedia accessories) and version of Microsoft® Windows
you are currently running.



Appendix 4: Limited Warranty

Before release, our applications software is tested on a wide variety of hardware configurations, under the most
rigorous test conditions possible. We therefore warrant that the software will perform in substantial compliance
with the specifications set forth in this documentation, provided that the software is used on the computer
hardware and operating system(s) for which it was designed.

Neither the author nor Pegasus Development make any other warranties, expressed or implied, with respect to this
software or host media, including its quality or fitness for a particular purpose.

In no event will the author or Pegasus Development be liable for any direct, indirect, special, incidental, or
consequential damages arising from the use of or the inability to use this software, even if Pegasus Development
has been advised of the possibility of such damages.

Neither the author nor Pegasus Development is responsible for any costs including, but not limited to, those
incurred as a result of lost profits or revenues, loss of time or use of the software, loss of data, the cost of
recovering software or data, the cost of substitute software, claims by third parties, or similar costs. In no event
will Pegasus Development's liability exceed the amount of the paid purchase/license fee.

The terms of this warranty are limited to the Yakkity Clock executable and all support libraries included in the
original product. The terms of this warranty do not extend to multimedia files (waveform audio files or MIDI
sequencer files) or audio CD data used with or accessed from this product.



Appendix 5: About Yakkity Clock

YAKKITY CLOCK FOR WINDOWS
Version 2.00

P E G A S U S D E V E L O P M E
N T

Copyright © 1994-1997 Matthew T. Smith
Pegasus Development, St. Louis, Missouri, USA

Yakkity Clock is distributed by Advanced Support Group, Inc. of St. Louis, Missouri, USA

Yakkity Clock was written for use in the Microsoft® Windows operating environment (including versions 3.1, 3.11,
Windows 95 or later, and Windows NT 3.1 or later).

Microsoft® is a registered trademark and Windows is a trademark of Microsoft Corporation.

All other trademarks mentioned herein are trademarks or registered trademarks of their respective corporations,
and are hereby acknowledged.



Caption Bar
The caption bar is a standard window element. Users can move the Yakkity Clock program window by clicking and
dragging the caption bar. The caption bar can optionally be configured to display the current time.



Menu Bar
The menu bar is a standard window element. The menu bar provides convenient access to all program features.
Selected menu commands can also be accessed via hotkey combinations.



LED Clock Face
The LED clock face is the main element of the Yakkity Clock interface. This is where the current time is displayed.



Voice-Time Button
The voice-time button at the bottom of the program window triggers a voice time report.



File / Exit
This command closes Yakkity Clock.



Options / Configure...
This command displays the Yakkity Clock Configuration dialog box, where the program's configuration settings can
be modified. This command can also be invoked via the Alt+C key combination.



Options / Set Alarm 1...

This command displays a dialog box in which alarm #1 is set. Each alarm can be assigned a different sound or
music (either "built-in" sound effects, multimedia files, or audio CD tracks). The Yakkity Clock alarm feature can
also be used to launch an assigned application. This command can also be invoked via the Alt+1 key combination.



Options / Set Alarm 2...

This command displays a dialog box in which alarm #2 is set. Each alarm can be assigned a different sound or
music (either "built-in" sound effects, multimedia files, or audio CD tracks). The Yakkity Clock alarm feature can
also be used to launch an assigned application. This command can also be invoked via the Alt+2 key combination.



Options / Set Alarm 3...

This command displays a dialog box in which alarm #3 is set. Each alarm can be assigned a different sound or
music (either "built-in" sound effects, multimedia files, or audio CD tracks). The Yakkity Clock alarm feature can
also be used to launch an assigned application. This command can also be invoked via the Alt+3 key combination.



Options / Set Alarm 4...

This command displays a dialog box in which alarm #4 is set. Each alarm can be assigned a different sound or
music (either "built-in" sound effects, multimedia files, or audio CD tracks). The Yakkity Clock alarm feature can
also be used to launch an assigned application. This command can also be invoked via the Alt+4 key combination.



Help / Contents
This command launches the Windows help system and automatically loads this program's help file, YAKCLOCK.HLP.
This command can also be invoked via the F1 key



Help / Registration Information...
This command displays a dialog box containing product registration information.



Help / About Yakkity Clock...
This command displays a dialog box with this program's version number and copyright information.









